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What the elder person is followed by others;
What he demonstrates by action that people follow”

-Bhagwad Gita
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CHAPTER - 1 

INTRODUCTION TO COMPUTER 

WHAT IS A COMPUTER? 

A Computer is an Electronic Machine which accepts the Data, Process it, stores in 

its memory and gives out the result. The word computer is derived from Latin word 

compute which means to calculate or manipulate. It performs four basic operations:  

 Accepting Data, information and instructions from the user.  

 Processing the data and information. 

 Storing the data, information and instructions from the memory 

 Executing the data and information. 

Based on these operations the structure of a computer can be pictured as  

 

CHARACTERISTICS AND CAPABILITIES OF COMPUTER 

Speed: Current computers systems can amass manipulate and provide data in fractions of 

a second. Computer can [perform in minute’s task that would take a person year to 

complete. The speed of a computer is closely related to the amount of date it must 

process. 

Accuracy: The computer must process data accurately as well as quickly. Accuracy is a 

prime consideration in installing computers. Computers rarely make mistakes and can 

accurately perform all kinds of complex computations. 

Reliability: Computer systems are particularly adept at repetitive tasks. They do not take 

sick days and coffee breaks. Computer systems are widely accepted because of their 
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exceptional reliability. Unlike most humans, they are capable of operating under the most 

adverse conditions for extended periods of time without showing any signs of fatigue.  

Storage Capability: Computer systems have total and instant recall of data and an 

almost unlimited capacity to store the data. A typical mainframe computer system will 

have many billions characters and perhaps thousands of graphic images, stored and 

available for instant recall. 

Reduced Costs: With the ever-increasing advances being made in the state-of the art, the 

cost of computer equipment has dropped drastically over the years. Hardware cost of 

acquiring their own computer system many now find it not only feasible to acquire a 

system, but cost-effective as well. 

Versatility: Computers are being used in different fields such as offices, schools, 

hospitals etc. to perform various tasks. Versatile means ability to perform various tasks 

and computer can capable to do so. A computer can process any kind of data.  

HISTORY OF COMPUTERS 

               Today, computer can be seen almost everywhere from office, shopping malls, 

schools, to almost every home. Computers are as common place as pencils and have been 

marketed in such a way as make them available to almost anyone, it has gone through 

many stages of evolution and it is continuously changing. To fully understand and 

appreciate the impact that computers have on our lives and promises they hold for the 

future, it is important to understand their evolution.  

Early Computing Machine 

                The Abacus, which emerged about 5,000 

years ago in Asia Minor and is still in use, and may be 

considered as the first computer. This device allows 

users to make computations using a system of sliding beads arranged on a rack. Early 

merchants used the abacus to keep trading transactions. 

 First mechanical adding machine was invented 

by Braise Pascal in 1642 Pascal’s device used a base 

of ten to perform calculations. The drawback to the 

Pascaline, of course, was its limitation to addition. It 

used eight movable wheels to add the sums up to eight 

digits.  
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               The real beginnings of computers as we know them 

today, however, lay with an English mathematics professor, 

Charles Babbage. (1791- 1871) “Charles Babbage is known as 

father of computers”. Babbage’ developed machine to perform 

differential equations, called a difference engine. It was powered 

by steam and large as a locomotive, could perform calculations 

and print the results automatically.  

               After working on difference engine for 10 years, Babbage was suddenly 

inspired to begin work on the fist general-purpose computer, which he called the 

analytical engine. 

               Babbage’s steam- powered analytical engine. 

Ultimately was never constructed, it may seem primitive by 

today’s standards. However, it outlined the basic elements of a 

modern general – purpose computer and was a breakthrough 

concept. Babbage borrowed the idea of punch cards to encode 

the machine’s instructions from the jacquard loom... the loom, 

produced in 1820 and named after its inventor, Joseph- Marie 

jacquard, used punched boards that controlled the patterns to 

be woven. Babbage assistant Augusta lady was instrumental in 

designing analytical engine. 

           In 1889, an American inventor, Herman Hollerith, also applied the jacquard 

loom concept to computing. Hollerith’s method used cards to store data or information, 

which he fed into a machine that compiled the results mechanically.  

           Instead of ten years, census takers compiled their results in just six weeks with 

Hollerith’s machine. In addition to their speed, the punch cards served as a storage 

method for data and they helped to reduce computational errors. Hollerith brought his 

punch card reader into the business world, finding the tabulating Machine Company in 

1896, later to become International Business machines (IBM) in 1924 after a series of 

mergers. Both business and government used punch cards for data processing until then 

1960’s 

GENERATIONS OF COMPUTER 

Generation in computer terminology is a change in technology a computer is/was 
being used. Initially, the generation term was used to distinguish between varying 
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hardware technologies. But nowadays, generation includes both hardware and software, 

which together make up an entire computer system. 

There are totally five computer generations known till date. Each generation has 

been discussed in detail along with their time period, characteristics. We've used 

approximate dates against each generation which are normally accepted.  

Following are the main five generations of computers: 

Sl.No Generation Year Description 

01 First Generation 1946-1959 Vacuum tube based 

02 Second Generation 1959-1965 Transistor based 

03 Third Generation 1965-1971 Integrated Circuit based 

04 Fourth Generation 1971-1980 VLSI microprocessor based 

05 Fifth Generation 1980-onwards ULSI microprocessor based 

 

First Generation of Computer (1946-1959) 

First generation of computers started with using vacuum tubes as the basic 
components for memory and circuitry for CPU (Central Processing Unit). These tubes 

like electric bulbs produced a lot of heat and were prone to frequent fusing of the 

installations, therefore, were very expensive and could be afforded only by very large 

organizations. 

In this generation, mainly batch processing operating systems were used. In this 

generation, Punched cards, Paper tape, Magnetic tape Input & Output device were used. 

There were machine codes and electric wired board languages used. 

Some computers of this generation were ENIAC, EDVAC, UNIVAC, IBM-701, 
and IBM-650 
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The main features of First Generation are: 

 Vacuum tube technology 

 Unreliable, Very costly 

 Supported Machine language only 

 Generate lot of heat  & Need of A.C. 

 Slow Input/output device 

 Huge size, Non-portable 

 Consumed lot of electricity 

Second Generation of Computer (1959-1965) 

This generation using the transistor was 

cheaper, consumed less power, more compact in 

size, more reliable and faster than the first 

generation machines made of vacuum tubes. In this 

generation, magnetic cores were used as primary 

memory and magnetic tape and magnetic disks as 

secondary storage devices. 

In this generation, assembly language and 

high-level programming language like FORTRAN, 

COBOL was used. There was Batch processing and 

Multiprogramming Operating system used.  

Some computers of this generation were IBM 1620, IBM 7094, CDC 1604, CDC 

3600, and UNIVAC 1108 

The main features of Second Generation are: 

 Use of transistors 

 Reliable as compared to First generation computers 

 Smaller size as compared to First generation computers 

 Generate less heat as compared to First generation computers 

 Consumed less electricity as compared to First generation computers  

 Faster than first generation computers 

 Still very costly 

 A.C. needed 

 Support machine and assembly languages  
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Third Generation of Computer (1965-1971) 

The third generation of computer is marked by the use of Integrated Circuits (IC's) 

in place of transistors. A single IC has many transistors, resistors and capacitors along 

with the associated circuitry. The IC was invented by Jack Kilby. This development  made 

computers smaller in size, reliable and efficient. 

In this generation, Remote processing, Time-sharing, Real-time, Multi-

programming Operating System were used. High-level language (FORTRAN-II TO IV, 

COBOL, PASCAL PL/1, BASIC, ALGOL-68, etc.) were used during this generation. 

Some computers of this generation were IBM-360 series, Honeywell-6000 series, 

PDP (Personal Data Processor), IBM-370/168, TDC-316 

The main features of Third Generation are:  

 IC used 

 More reliable 

 Smaller size and Faster 

 Generate less heat 

 Lesser maintenance 

 Still costly 

 A.C. needed 

 Consumed lesser electricity 

 Support high-level language 

Fourth Generation of Computer (1971-1980) 

The fourth generation of computers is marked by the use of Very Large Scale 

Integrated (VLSI) circuits. VLSI circuits having about 5000 transistors and other circuit 
elements and their associated circuits on a single chip made it possible to have 

microcomputers of fourth generation. Fourth Generation computers became more 

powerful, compact, reliable, and affordable. As a result, it gave rise to personal computer 

(PC) revolution. 

In this generation, Time sharing, Real time, Networks, Distributed Operating 

System were used. All the higher level languages like C and C++, DBASE, etc., were 

used in this generation. 

Some computers of this generation were DEC 10, STAR 1000, PDP 11, CRAY-1 

(Super Computer), CRAY-X-MP (Super Computer). 
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The main features of Fourth Generation are: 

 VLSI technology used 

 Very cheap 

 Portable and reliable 

 Use of PC's 

 Very small size  

 Pipeline processing 

 No A.C. needed 

 Concept of internet was introduced 

 Great developments in the fields of networks  

 Computers became easily available 

Fifth Generation of Computer (1980-till date) 

In the fifth generation, the VLSI technology became ULSI (Ultra Large Scale 

Integration) technology, resulting in the production of microprocessor chips having ten 

million electronic components.  

This generation is based on parallel processing hardware and AI (Artificial 

Intelligence) software. AI is an emerging branch in computer science which interprets 
means and methods of making computers think like human beings. All the higher level 

languages like C and C++, Java, .Net, etc., are used in this generation. 

Some computers types of this generation are Desktop, Laptop, NoteBook, 

UltraBook, ChromeBook. 

The main features of Fifth Generation are:  

 ULSI technology 

 Development of true artificial intelligence 

 Development of Natural language processing 

 Advancement in Parallel Processing 

 Advancement in Superconductor technology 

 More user friendly interfaces with multimedia 

features 
 Availability of very powerful and compact 

computers at cheaper rates 
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APPLICATIONS OF COMPUTER 

Computer in Business 

The computer's characteristic as high speed of calculation, diligence, accuracy, 
reliability, or versatility has made it an integrated part in all business organizations.  

Computer is used in business organization for: 

 Payroll Calculations  

 Budgeting 

 Sales Analysis 

 Financial forecasting 

 Managing employees database  

 Maintenance of stocks, etc. 

 

Computer in Banking 

Today Banking is almost totally dependent on 

computer. Banks provide following facilities: 

 Banks on-line accounting facility, which includes 
current balances, deposits, overdrafts, interest 

charges, shares and trustee records. 

 ATM machines are making it even easier for 

customers to deal with banks. 

Computer in Education 

The computer has provided a lot of facilities in the Education System.  

 The uses of computer provide a tool in the 

Education system known as CBE (Computer Based 

Education).  

 CBE involves Control, Delivery and Evaluation of 

learning. 

 The computer education is very familiar and rapidly 

increasing the graph of computer students.  

 There are number of methods in which educational institutions can use computer 

to educate the students. 

 It is used for prepare a database about student performance and analyses are 

carried out. 



8
th

 Standard  P a g e  | 9 

          KARNATAK RESIDENTIAL EDUCTIONAL INSTITUTIONS SOCIETY, BANGALORE    

Computer in Health Care 

Computers have become important part in all 

Medical Systems. The computers are being used in 

hospitals to keep the record of patients and medicines. It 

is also used in scanning and diagnosing different 

diseases. ECG, EEG, Ultrasounds and CT Scans, etc., 
are also done by computerized machines. 

Some of major fields of health care in which computers 

are used: 

 Diagnostic System: Computers are used to collect data and identify cause of 

illness. 

 Lab-diagnostic System: All tests can be done and reports are prepared by 

computer. 

 Patient Monitoring System: These are used to check patient's signs for 

abnormality such as in Cardiac Arrest, ECG, etc.  

 Pharma Information System: Computer checks Drug-Labels, Expiry dates, 

harmful drug side effects, etc. 

 Nowadays, computers are also used in performing surgery. 

Computer in Engineering Design 

Computers are widely used in engineering 

purposes. One of major areas is CAD (Computer aided 

design). CAD provides creation, edition, and 
modification of image. Some fields are: 

 Structural Engineering: Requires stress and 

strain analysis required for design of Ships, 

Buildings, Budgets, Airplanes, etc. 

 Industrial Engineering: Computers deal with design, implementation and 

improvement of Integrated systems of people, materials and equipments.  

 Architectural Engineering: Computers help in planning towns, designing 

buildings, determining a range of buildings on a site using both 2D and 3D 

drawings. 

Computer in Military 

Computers are largely used in defense. Modern tanks, 

missiles, weapons, etc., employ computerized control systems. 

Some military areas where a computer has been used are: 
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 Missile Control 

 Military Communication 

 Military operation and planning 

 Smart Weapons 

Computer in Communication 

Communication means to convey a message, an idea, a picture or speech that is 

received and understood clearly and correctly by the person for whom it is meant. Some 

main areas in this category are: 

 E-mail 

 Chatting 

 Usenet 

 FTP 

 Telnet 

 Video-conferencing 

 

Computer in Government Applications 

Computers play an important role in government applications. Some major fields in this 

category are: 

 Budgets 

 Sales tax department 

 Income tax department 

 Male/Female ratio  

 Computerization of voters lists 

 Computerization of Driving Licensing system 

 Computerization of PAN card 

 Weather Forecasting. 
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CHAPTER - 2 

MS-WORD AND DRAWING TOOLBAR 

INTRODUCTION 

Ms-Word is an advanced word processing program, developed by Microsoft 

Corporation USA. It is a family member of Ms-Office group. With the help of this 

program we can create any type of documents report, thesis, designing & news paper etc. 

It also saves the document for future use with revision facility. 

STARTING MS-WORD 

This will show you how to start Microsoft Word: 

1.   Click the Start button - the Start menu appears  

2.   Point to the entry for All Programs 

3.   Click on the entry for Microsoft Office – Word 2007 

 

 

 

 

 

 

 

The Microsoft Word program will load, and a blank document will appear on your  

MICROSOFT WORD BASICS 

Typing Text  

To enter text, type just as you would if you were using a typewriter. To capitalize 

a letter, hold down the SHIFT key while typing the letter. Or, press the CAPS LOCK 

key on the left-hand side of your keyboard. You will have to press the CAPS LOCK key 

again—once you are done capitalizing—to remove the lock. You do not need to press 

ENTER to start a new line—Microsoft Word will automatically wrap your sentence at 

the end of the line. 

To move the cursor from its position at the end of your sentence to anywhere else 

on the page, use the mouse or the arrow keys to move the cursor where you want the 

letters or spaces to be (left-click the mouse to place the cursor) and then type what you 
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want to add—the text will automatically adjust to include it. Press ENTER to start a new 

paragraph (this is sometimes called a “carriage return”). 

Deleting Text  

While typing a document, sometimes you will make a mistake. Unlike a 

typewriter, MS Word can delete text on the screen and leave no trace—it is as if you 

never typed on the page in the first place. 

There are two different buttons on the keyboard that will allow you to erase text. 

They are the “Delete” key and the “Backspace” key (#s 1 and 2 on the keyboard map on 

page. The “Backspace” key deletes words to the LEFT of the cursor, and the “Delete” 

key deletes words to the RIGHT of the cursor. 

This is my crea | tive sentence. 

BACKSPACE ↔ DELETE 

Undoing and Redoing 

The UNDO and REDO features of Microsoft Windows applications are great tools to 

rely on (especially in MS Word). The program will keep a list of the last 25 commands 

that you have performed, and it allows for taking “one step” backwards in order to erase 

what you have just done. 

Click on the UNDO button in the Quick Access Toolbar to go back one step (up 

to 25). 

Click on the REDO button in the Quick Access Toolbar to go forward one step 

(up to 25). 

 

Formatting Text  

Changing the look of what you’ve written is called “formatting.” This can include 

changing the text style, size, color, and more. 

This is a sentence that features many different fonts. 

This is a sentence that features many different sizes. 

From the Home Tab, the “B” will make your text BOLD , the “I” will put it in 

italics, and the “U” will add an underline to your text.  These features do not have to be 
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used independently of each other—in other words, you can bold, underline, and italicize a 

single piece of text. 

The alignment of the text can be altered using the buttons with the horizontal lines 

on them. You can align text 

To The LEFT 

To The CENTER 

To The RIGHT 

Cutting, Copying, and Pasting Text  

In MS Word, you can CUT or COPY text from one area 

of the document and save that text to be PASTED elsewhere 

(these commands are found on the Home Tab). When you CUT 

text, you actually delete it from where you took it, as opposed to 

COPYING it, which makes a copy of your selection. 

CUTTING a selection will place it on the clipboard, just in case you want to PASTE it 

elsewhere. To CUT a selection, first highlight it. Then, click on the CUT icon from the 

Home Tab. 

The highlighted text will disappear, as you have just cut it out, but a copy is now on your 

clipboard, and MS Word is waiting for you to paste it somewhere else. 

To PASTE this cut selection, place your cursor where you want the selection to go. Click 

on the PASTE icon from the Home Tab toolbar, and it will pop the text into place, right 

where you have your cursor. 

To COPY, simply follow those same steps, replacing the CUT command with COPY. 

The COPY command will not alter your original selection at all, as it simply makes a 

copy of the selection without changing or deleting it in any way.  

HOW TO USE DRAWING OBJECTS 

Drawing objects include shapes, diagrams, flowcharts, curves, lines, and WordArt. These 

objects are part of your document. You can change and enhance these objects with colors, 

patterns, borders, and other effects. A drawing in Word refers to a drawing object or a 

group of drawing objects. For example, a drawing object that is made up of shapes and 

lines is a drawing.  

javascript:AppendPopup(this,'OfWordart_1')
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Drawing an Object on the Document  

It’s really easy to insert shapes to your document. Here’s 

what you need to do: 

1. Click in your document where you want to create 

the drawing.  

2. Click on the Insert ribbon tab. 

3. Click on the Shapes button, and then click New 

Drawing Canvas. 

A drawing canvas is inserted into your document. 

CHANGING OBJECT SIZE 

When you insert a drawing canvas, you can do any of the following on the Format 

tab under Drawing Tools:  

1. Click a shape or shapes to insert into your document. You can also change 

the shape and add text to it. 

2. Draw on the canvas. To draw, click Shapes, and then click Freeform or 

Scribble under Lines.  

3. Adjust the size of the canvas by selecting it and then clicking the arrows in 

the Size group, or click the Size Dialog Box Launcher to specify more 

precise measurements.  

4. Apply a style to a shape. In the Shape Styles group, rest your pointer over a 

style to see what your shape will look like when you apply that style. Click 

the style to apply it. Or, click Shape Fill or Shape Outline and select the 

options that you want.  

 
5. Use shadow and three-dimensional (3-D) effects to 

add interest to the shapes in your drawing.  

6. Align the objects on the canvas. To align the objects, 

press and hold CTRL while you select the objects 

that you want to align. In the Arrange group, click 

Align to choose from an assortment of alignment commands.  
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WORDART 

How would you like to create cool text effects with shadows and 3D? Check out 

the WordArt functions! 

1. Select the text to which you want to add WordArt effects. 

2. Click the WordArt button on the Insert ribbon. 

3. A selection of WordArt design 

options will appear. 

4. Click on a design option to 

select it. 

5. The Edit WordArt Text dialog 

box will allow you to change 

the font style and size. 

6. Click OK to accept the 

settings. 

 

 

 

 

Your selected text will be transformed by the WordArt you have chosen! 

 

 
 

Draw Textbox 

You’d like to draw textbox in your 

document? It couldn’t be easier! Here’s how 

it’s done: 

1. Click on the Insert ribbon tab. 

2. Click on the TextBox button. 
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3. A selection of Text Box design options will appear.  

4. Click on a design option to select it. 

5. Edit the text in Text Box and you can position the Text Box anywhere in your 

document.  

Adding Pictures, ClipArt and Smart Art  

These are the basic types of graphics that you can use to enhance Word 

documents: drawing objects, Smart Art, charts, pictures, and clip art. Drawings refer to a 

drawing object or a group of drawing objects. 

 

Adding Picture to documents 

It’s really easy to insert a picture to your document. Here’s what you need to do:  

1. Click at the point in your document where you’d like to add a Picture.  

2. Click on the Insert ribbon tab. 

3. Click on the Picture button. 

4. Locate the picture that you want to insert.  

5. Double-click the picture that you want to insert. 

 

Adding ClipArt graphics to documents 

You can add pizzazz to your documents with ClipArt, the ready-made 

pictures that come with Word! Here’s what you need to do to add ClipArt graphics to 

your document: 

1. Click at the point in your document where you’d 

like to add a ClipArt graphic. 

2. Click on the Insert ribbon tab. 

3. Click on the ClipArt button. 

4. A ClipArt pane will open on the right of your 

document. 

5. Type a descriptive term in the Search For field, 

for example sport. Then click Go or press 
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[ENTER]. 

6. The ClipArt Gallery will show you all the available graphics related to this 

theme. 

7. Clicking on a picture will insert it in your document.  

 

To remove a graphic from your document, click on it and then press the [DEL] key.  

Adding Smart Art to documents 

        It’s really easy to insert smart to your 

document. Here’s what you need to do: 

1. Click in your document where you want to 

create the drawing.  

2. Click on the Insert ribbon tab. 

3. Click on the SmartArt button, and then 

choose a SmartArt Graphic which you want. 

TABLES 

If you need to include structured text in your document, then using a table is the 

easiest way to make sure that it will remain neatly formatted, even when you edit it.  

Creating a table 

It’s really easy to create a table. Here’s what you need to do: 

1. Click at the point in your document where you’d like to 

add a table. 

2. Click on the Insert ribbon tab. 

3. Click on the Table button just below the Insert tab. 

4. A blank table grid will appear. 

5. Position the mouse pointer in the top left square 

of the table grid. Click the left button, and hold it 

down while dragging the mouse down and to the 

right. This is how you specify the number of 

columns and rows you’d like in your table. 

6. Release the left mouse button, and the 

framework of your table is included in the 

document. 
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After you create a table, the Design ribbon will be displayed giving you a choice of 

standard table styles. Or use the Borders and Shading buttons to design your own! 

Adding text to your table 

You want to fill the table in? Nothing could be easier! 

1. After you’ve created the table, the cursor will be blinking in the first cell. You can 

begin typing here. 

2. To move on to the next cell, just press the [TAB] key.  

3. When you want to move to the next line, just press [TAB] again. Don’t press 

[ENTER] – that will create a new line inside the current cell.  

 

Adding rows and columns 

You need to have the Layout ribbon visible for this too. 

1. Position the cursor in the row (column) next to which 

you want add another row (column). 

2. Click on one of the Rows & Columns options (located on the right of the Delete 

button). The new row or column will be included in your table.  

 

Deleting rows and columns  

You’d like to delete a row? Or a column? Here show:  

1. Position the cursor in the row or column that you want to 

get rid of. 

2. Click on the Layout ribbon tab. 

3. Click on the Delete button, and a drop-down menu will 

appear. 

4. Select an option to delete cells, columns, rows, or even 

the entire table. 

Merge Cells 

If you want to merge the two or more cells in table? 

1. Select two or more cells to be merged. 

2. Click on the Layout ribbon tab. 

3. Click on the Merge Cells button. 
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Split a Cell 

If you want to split the cells in table? 

1.  Select the cell to be divided. 
2. Click on the Layout ribbon tab. 

3. Click on the Split Cells button and specify the 

number of rows and columns to split the cell into.  

 
Formatting Cells 

You can easily format the cells. Here’s what you need to do:  

To Change the Alignment of the Text in a Cell 

1. Place the cursor in a cell or select multiple cells or 

select the whole table. 

2. Select the appropriate text alignment template from 

the Layout ribbon tab. 

Auto Fit 

To fit the cell automatically in a table  

 

1. Select the table. 

2. Click on the Layout ribbon tab. 

3. Click on the AutoFit button, and a drop-down menu 

will appear. 

4. Select an option to auto the entire table. 

 

Table Properties 

 

The preferred method for changing the size of a row or column is to right-click in 

a cell in the row or column and selects “Table Properties…” from the menu. This action 

opens the Table Properties dialog box, which allows the user to specify the alignment of 
the table, the size of rows and columns as well as to indicate how text wraps around the 

table. 

 

 



8
th

 Standard  P a g e  | 20 

          KARNATAK RESIDENTIAL EDUCTIONAL INSTITUTIONS SOCIETY, BANGALORE    

CHAPTER - 3 

MS-DOS 

INTRODUCTION 

The word DOS is often taken to stand for Disk Operating System, but this is not 

historically accurate. The current versions of DOS were developed from QDOS, which 

stood for Quick and Dirty Operating System, a reference to the fact that it was a simple 

and not very sophisticated system in comparison to others around at the time! 

At one time, most PCs used DOS as their primary OS. Back then it looked after 

everything: the hard disk, the CPU, the memory, and communication with I/O devices 

such as the keyboard and printer. Gradually, Windows took over and DOS was relegated 

to the background. In fact, many people today are unaware of its continued existence. 

However, it still has an important role to play in running modern computers and a vital 

role when it comes to maintenance and trouble shooting. 

 

Unlike Windows, this uses a graphical user interface (GUI), DOS uses a Text User 

Interface (TUI) i.e. you type commands and the computer carries out your instruction. 

This makes it less "user friendly" as you have to remember lots of individual commands - 

and if you make a tiny mistake, it won't understand you! On the other hand, once you 

have learnt DOS you will have a better understanding of how a computer operates and the 

underlying directory structure of your hard disk. Hence it is worth making the effort to get 

to know it well. 

MS-DOS commands perform tasks like: 

 Manage files and directories 

 Maintain Disks 

 Configure Hardware and Networking 

 Optimize the use of memory 

 Customize MS-DOS 

STARTING DOS 

There are several ways to get to DOS, but the easiest is from within Windows is 

1. Click Start 

2. Select Programs in that Accessories 

3. Click on Command Prompt 

http://tech-wonders.blogspot.com/2010/05/primary-memory-is-ram-and-rom.html
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DOS will open in a window rather like any other program window, except that it 

has white text on a black background and a rather strange-looking tool bar.  

 

The screen will clear and you will be left at the command prompt which, by default, looks 

like: 

 
 

The flashing cursor (an underscore) means that it is ready to accept an input from the 

keyboard. 

 

DOS Commands are divided into 2 types: 

1. Internal Commands 

2. External Commands 

Internal Commands: 

These are for performing basic operations on files and directories and they do not 

need any external file support. 

Some of the Internal Commands are: 

1. DATE 

This command is used to display the system current date setting and prompt you 

to enter a new date. The syntax is: DATE  [/T | date] 

If you type DATE without parameters then it displays current date and prompts to 

enter new date. We should give new date in mm-dd-yy format. If you want to keep the 

same date just Press ENTER. DATE command with /T switch tells the command to just 

output the current system date, without prompting for a new date. 
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2. TIME 

This command is used to displays or set the system time. The syntax is: TIME  [/T | time] 

Same as DATE command, typing TIME with no parameters displays the current time and 

a prompt for a new one. Press ENTER to keep the same time.  

3. COPY CON 

It is used to create a file in the existing 

directory. Here CON is a DOS reserved word 

which stands for console.  Syntax 

is: COPY CON filename after that press 

Enter and start typing your text and after 

you're done typing your text, to save and exit 

hit F6 key. 

 

4. TYPE 

This command is used to display the contents of a text file or files. The syntax 

is: TYPE  [drive:][path]filename 

5. CLS 

It is used to clear the screen. Syntax is CLS 

 
6. REN 

This command is used to change/modify the name of a file or files.   

The Syntax is: REN [drive:] [path] filename1 filename2.  
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Here, filename1 is source file for which you wanted to change the name, and 

filename2 will obviously becomes your new file name. Also note that you cannot specify 

a new drive or path for your destination file. 

7. VER 

This command displays the version of the Microsoft Windows running on 

your computer. The Syntax is: VER [drive:] [path]  
 

 

8. PATH 

This command displays the path that how we have come to the present position or 

sets a search path for executable files. Its Syntax is PATH [drive:] [path]  
 

 
9. DIR 

This command displays a list of files and subdirectories in a directory. Syntax 

is: DIR   [drive:] [path] 
 

 
 

10.  VOL 

It displays the disk volume label and serial number, if they exist for the drive 

specified. If no drive is specified it displays for the active drive. 

The Syntax is VOL  [drive:] 
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11.  DEL/ERASE 

It is used to delete one or more files. The Syntax 

is DEL names 
 

12.   MD, CD and RD 

a. MD (or MKDIR) command stand for make directory and it is used to create a 

directory. The Syntax is MD   [drive:]path]  
 

b. CD (or CHDIR) stands for create or change directory and it allows displaying 

the name of or changing the current directory or rather we can say come out of 

a directory. The Syntax is CD   [/D]   [drive:][path]  
 

c. RD (or RMDIR)  command removes or deletes a directory. There are two 

conditions to remove any directory - (1) Directory to be removed should be 

empty. And (2) we should be outside the directory we are commanding to 

delete. The Syntax is RD [drive:] path  

 

 

 

 

External Commands: 

These external commands are for performing advanced tasks and they do need 

some external file support as they are not stored in COMMAND.COM 

Some of the External Commands are: 

 

1. EDIT 
 

This command is used to 

modify or change the data of a 

file. The Syntax is  

EDIT  [filename(s)] 
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2. LABEL 

It is used to create, change, or delete the volume label of a disk. The Syntax is  

LABEL [drive:] [label] 

  

3. CHKDSK 

This command is used to check a disk and display a status report with properties 

of disk like serial number, volume label, memory and other properties along with errors 

on the disk if any. The Syntax is CHKDSK   [volume path]    
 

 
 

4. TREE 
 

This command is very useful to view the list of directories and subdirectories present 

on the disk in graphical form. Here is the syntax for this command with allowed 

switches: TREE [drive][path]  

5. DOSKEY 

This command is generally used to edits command lines and recalls commands. 

The Syntax is DOSKEY  [/REINSTALL]  [/HISTORY] [text] 
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Here, /REINSTALL installs new copy of doskey, /HISTORY is used to 

display all previously given commands stored in memory. And [text] specifies the 

commands you want to record.  

 

6. SORT 

This command is used to arrange the data of a file in alphabetical order (A-Z, 0-9) or 

reverse alphabetical order. The Syntax is SORT   [/R]   [[drive1:][path]  

/R in command line reverses the sort order 

 

 

 

 

 

 

http://tech-wonders.blogspot.com/2010/08/units-of-measure-for-digital.html
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CHAPTER - 4 

HTML 

Introduction to HTML 

HTML is a tag based language used to “markup” specific parts of a web page for 

display. By adding tags to the page, you can give instructions to the web browser about 

how you want the page displayed. 

 The Hyper Text Mark Up in HTML stands for its capability to link a text or 

graphics hotspot to other web pages. This powerful feature, the hyperlinks, is one of the 

main reasons HTML was adopted as the language for web.  

 HTML is maintained by a standard body called the World Wide Web consortium 

(W3C). It is subset of SGML (Standardized General markup Language). 

A Brief history of HTML 

In the late 1980s, Tim Berners-Lee was working as a physicist at CERN (the 

European Organization for Nuclear Research). He devised a way for scientists to share 

documents over the internet. Prior to his invention, communication via the internet was 

limited to plain text, using technologies such as email, FTP (File Transfer Protocol), 

and Usenet-based discussion boards. The invention of HTML made use of a model of 

content stored on a central server that could be transferred and displayed on a local 

workstation via a browser. It simplified access to content and enabled the display of 

"rich" content (such as sophisticated text formatting and the display of images).  

What is HTML? 

HTML is a markup language. It tells the web browser what content to display. 

HTML separates "content" (words, images, audio, video, and so on) from "presentation" 

(the definition of the type of content and the instructions for how that type of content 

should be displayed). HTML uses a pre-defined set of elements to identify content types. 

Elements contain one or more "tags" that contain or express content. Tags are surrounded 

by angle brackets, and the "closing" tag (the one that indicates the end of the content) is 

prefixed by a forward slash. 

For example, the paragraph element consists of the start tag "<p>" and the closing tag 

"</p>".  

http://en.wikipedia.org/wiki/Ftp
http://en.wikipedia.org/wiki/Usenet
https://developer.mozilla.org/en-US/docs/Glossary/HTML
https://developer.mozilla.org/en-US/docs/Glossary/Element
https://developer.mozilla.org/en-US/docs/Glossary/Tag
https://developer.mozilla.org/en-US/docs/Glossary/Tag
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HTML – Basic structure 

HTML consists of a set of elements. Elements define the semantic meaning of 

their content. Elements include everything between two matching element tags, including 

the tags themselves.  

Most elements may contain other elements, forming a hierarchic structure. A very simple 

but complete web page looks like this:  

 

Basic Tags of HTML 

HTML documents are written in plain text. They can be written in any text editor 

that allows content to be saved as plain text, such as Notepad, Notepad++. Tag names 

may be written in either upper or lower case. However, the W3C  recommends using 

lower case (and XHTML requires lower case). 

 

HTML attaches special meaning to anything that starts with the less-than sign 

("<") and ends with the greater-than sign (">"). Such markup is called a tag. Make sure to 

close the tag, as some tags are closed by default, whereas others might produce 

unexpected errors if you forget the end tag.  

Here is a simple example: 

<p> This is text within a paragraph</p>  

Some of the Basic Tags are 

 <HTML></HTML> Tag: It contains the entire document place these tags at the 

top and bottom of you HTML file. 

 <HEAD></HEAD> Tag: It contains document head information and do not 

contain any of the page’s actual content. The page title, which browser’s use for 

bookmark and favorites list, should be including in these tags. You can also place 

https://developer.mozilla.org/en-US/docs/Glossary/Tag
https://developer.mozilla.org/en-US/docs/Glossary/W3C
https://developer.mozilla.org/en-US/docs/XHTML
https://developer.mozilla.org/en-US/docs/Glossary/tag
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any of the following tags within the document head: <TITLE>, <SCRIPT>, 

<STYLE> 

 <TITLE></TITLE> Tag: It gives the document an official title. The <TITLE> 

tag appears inside the document header i.e. inside the <HEAD> tag.  

 <BODY></BODY> tag: It acts as a container for the body of the document. It 

appears after the <HEAD> tag and is followed by the </HTML> tag. The 

<BODY> tag also sets various color setting and background characteristics of the 

document. 

 Paragraph tag (<P></P>): One of the first formatting option you might want to 

use is to separate you text into paragraphs. The paragraph tags <P></P> the care 

of this for you. These add a blank line before and after the text they enclosed.  

 Line Break tag (<BR>): The line break tag <BR> places the text that follows on 

the left margin of the next line.  

 Bold & Italic Tag ( <B></B> & <I></I>): This physical formatting tag changes 

the appearance in your document. 

Creating an Simple HTML Document 

 

It’s really easy to create and view a simple 

HTML document. Here’s what you need to do: 

 

1. Click on the Start Button and Select 

Programs, then Accessories. 

2. Select the Notepad. 

3. In the Notepad window type the following 

text:  

<HTML>  

<HEAD>  

<TITLE>My First HTML Document</TITLE>  

</HEAD>  

<BODY>  

             This is my first HTML document. 

</BODY> 

</HTML> 

4. Within Notepad, select the File menu and choose the Save option.  

5. Choose the D: drive (for example) and name the file test.htm  
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After saving the file in Notepad, you have to test the HTML document in browser 

1. Click on the Start Button 

2. Select the Internet Explorer 

3. Type the file name path in address bar of Internet Explorer as D:\test.htm 
 

 
 

Adding Headers to your HTML Document 

 

To use the header tags in your HTML document. You will add the <H1> and 

<H2> header tags.  Headings can delimited using the <Hn> and </Hn> tags. There are 

six different levels, from <H1> the largest, down to <H6>. Header tags should not be 

nested. 

<HTML> 

<HEAD> 

<TITLE>Adding Headers </TITLE> 

</HEAD> 

<BODY> 

<H1>Heading Tag 1</H1>  

<H2>Heading Tag 2</H2> 

<P> Karnataka Residential Education Institutional Society</P>  

<P> Written by Keerthi </P> 

</BODY> 

</HTML> 
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Using Lists 

To add a bulleted list to your HTML document. You will use the <UL>, <OL> 

and <LI> tags. The <UL> … </UL> tags are used to define the start and end of an 

unordered list (bulleted). The <OL> … </OL> tags are used to define the start and end of 

an ordered list (numbered). The <LI> tag is used to define list items. 

<BODY> 

<P>I have created this document using Notepad.</P> 

<H2>Summary</H2> 

<P>So far I have learnt:</P> 

<UL> 

<LI>How the TITLE tag is displayed</LI> 

<LI>The role of the paragraph tag</LI> 

<LI>The use of the H1 and H2 tags for headings</LI> 

</UL> 

<P>I am about to learn the following two things : </P> 

<OL> 

<LI>About unordered (bulleted) lists</LI> 

<LI>About ordered (numbered) lists</LI> 

</OL> 

</BODY> 

 
 

Using Hypertext Links  

To create a hypertext link in your HTML document. You will use the <A> anchor 

tag to add a link to the KREIS home page.  The <A> tag is used to create links to other 
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files, either locally or on computers systems anywhere on the Internet. 

<HTML> 

<HEAD> 

<TITLE>Using Hyperlinks </TITLE> 

</HEAD> 

<BODY> 

<P>KREIS</P> 

<A HREF="www.kreis.kar.nic.in”> Click here </A> 

</BODY> 

</HTML> 

Note: Notice that the <A> tag always uses the syntax 

<A HREF=“http://domain_name/pathname”>link text</A> 

The attribute HREF is a mnemonic for ‘Hypertext REFerence’. 

The domain name is the name of the computer system (Web server) you wish to access. 

The pathname    \ refers to the name of the file you wish to retrieve and the directory in 

which it is located. 

Adding Images 

To add an image file to your HTML document. You will use the <IMG SRC 

=“image_filename”> tag to include an image. The <IMG SRC=“...”> tag specifies the 

location of an image. You will normally use GIF or JPEG image formats in HTML 

document. 

<HTML> 

<HEAD> 

<TITLE>Using Images </TITLE> 

</HEAD> 

<BODY> 

<P>KREIS</P> 

<IMG SRC=“D:/Logo.jpg” ALT=“KREIS, Bangalore”> 

</BODY> 

</HTML> 

The ALT=“…” attribute is used in order to provide a text alternative for browsers which 

can’t load images, or when loading of images is disabled. If the image was also a link to 

another page, you would include a full description. 
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Creating a Simple Table 

To create a simple table in your HTML document. You will use a number of basic 

table tags. These include <TABLE>, <TR>, <TH> and <TD>. 

 Tables are a useful tool for improving layout and fitting more information onto a 

page. Note that old browsers do not support them, and that they can cause difficulties for 

audio-enabled browsers as used by the visually impaired. 

<HTML> 

<HEAD> 

<TITLE>Tables </TITLE> 

</HEAD> 

<BODY> 

 <TABLE BORDER=”1”> 

  <TR> 

   <TH>Contents</TH> 

  </TR> 

<TR> 

<TD> Task 1 </TD> 

<TD> Getting Started </TD> 

<TD> Page 1 </TD> 

</TR> 

</TABLE> 

</BODY> 

</HTML> 

 

The <TABLE> ... </TABLE> tag is a container for the whole table. 

The <TR> ... </TR> tags define a table row and within this you use the <TD></TD>  

tags to define cells in the row (table data). 

The <TH> tag defines a heading, making the text inside it bold and centered. 

 

Adding a Background Color 

To familiarize yourself with background colors. You will set the background color 

for an HTML document. Using a background color can change the impact of your HTML 

page. 
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<HTML> 

<HEAD> 

<TITLE>My Color HTML Document</TITLE> 

</HEAD> 

<BODY BGCOLOR= “#FFDDDD”> 

<H2> This is my document</H2> 

</BODY> 

</HTML> 

Adding Color to Text and Links  

To change the color of your document’s text and hypertext links. You will 

use a number of <BODY> element attributes.  

These include TEXT=“#rrggbb”, LINK=“#rrggbb” and VLINK=“#rrggbb” 

(#rrggbb represents a hexadecimal color value, e.g. #FF0000 is red. Three pairs of digits 

are used to specify the proportion of red/green/blue in a particular color, hence known as 

RGB color values.)  

Setting colors in the BODY tag will change the text and link colors for the whole page. 

<BODY BGCOLOR=“#FFFFFF" TEXT=“#FF0000”> 

Adding Background Images 

To add an image to your HTML document background. You will use the 

BACKGROUND=“image.gif” attribute of the BODY tag. Using an image file as a 

background allows you to use textured effects. 

<BODY BACKGROUND=“D:/Image.gif”> 
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UÀÄgÀÄªÁV F ¥ÀÄ À̧ÛPÀªÀ£ÀÄß QgÀÄPÁtÂPÉAiÀiÁV ¤ªÀÄä PÉÊVqÀÄwÛzÉÝÃ£É.

F ¥ÀÄ À̧ÛPÀªÀÅ £À£Àß «zÁåyðUÀ¼À eÁÕ£ÀªÀ£ÀÄß ºÉaÑ À̧°, CªÀgÀÄ ¥ÀjÃPÉëUÀ¼À°è

AiÀÄ±À À̧Äì UÀ½ À̧ÄªÀAvÁUÀ°, CªÀgÀ fÃªÀ£À À̧ÄRªÁVgÀ° JAzÀÄ ºÁgÉÊ À̧ÄªÉ...............

EAw ¤ªÀÄä

QÃwð PÀÄªÀiÁgï ºÉZï.JA
PÀA¥ÀÆålgï ²PÀëPÀgÀÄ

ªÉÆ.zÉ.ªÀ.±Á¯É, ¨ÉÃ®ÆgÀÄ mË£ï

K Karnataka Residential Educational Institutional Society
#179, Roopa Complex, 1st Main Road Sheshadripuram, Bangalore 560 020


	8th First Page.pdf
	Acknowledgement.pdf
	8th Content.Pdf
	8Th Standard.Pdf
	2

	Last Page.pdf

